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Graphical User interface
Welcome to the POD® HD300 Edit Pilot’s Guide. This guide contains details of the POD® HD300 
Edit application’s features and functionality. All behaviors are the same on Mac® or Windows®, 
unless otherwise noted.

 

This Guide covers POD HD300 Edit software version 2.0 (or later). Note that it may be necessary to update 
your POD HD300 device’s firmware and/or device drivers for use with the latest Line 6 software. To check 
for all current updates for your device, see “Line 6 Monkey™ & Additional Resources” on page 3•1.

What’s in it for Me? 

POD HD300 Edit is a simple, but powerful, Preset editor/librarian application. With POD HD300 Edit 
you can:

• Access all the individual Amp & FX models’ parameters within one attractive Graphical User 
Interface

• Create and customize your own Tone Presets

• Backup and store an unlimited number of Preset & Bundle files on your computer

• Arrange all your POD HD300 Presets within the device’s User Bank locations, in whatever 
Channel order you prefer

• Tap into the Line 6 CustomTone™ site where you can share your POD HD300 Tones and 
download from the huge library of artist & user Presets!

http://line6.com/customtone/
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The Main GUI

In software terms, the main window of the POD HD300 Edit application is referred to as the Graphical 
User Interface (or “GUI”). Here we’ve laid out descriptions for all the important things you need to 
know as you start clicking around in there.

FX Panels

Save Panel

Presets Panel Tempo Panel

Signal Flow Panel Amp & DT Series Amp Panels

The POD HD300 Edit software’s main GUI

Save Panel

The buttons within the Save Panel allow you to “Send” and “Receive” Tone Preset data between the 
application and the POD HD300 device’s internal memory. Using the Send buttons overwrites the 
existing Preset data in your device’s internal memory, effectively Saving the transferred Preset(s) to 
your POD HD300.  

The Save Panel

• Send Selected button - Transfers the currently selected Preset (or multiple selected Presets*) 
from the application to the POD HD300, overwriting the respective Presets within the device’s 
internal memory.  



1•3

POD HD300 Edit:  GUI

*Note that the selected (highlighted) Preset may not be the one currently loaded in the editor. The SEND 
SELECTED and RECEIVE SELECTED buttons act only on the selected Preset(s). To select multiple Presets, 
hold Shift or Ctrl (Windows®), Cmd (Mac®) while clicking within the application’s Presets Panel.

• Send All button - Transfers all Presets (regardless of any selected Presets) from the application 
to the device, overwriting all Presets within the device’s User Bank locations.

• Receive Selected button - Transfers the currently selected Preset(s) from the device to the 
application.

• Receive All button - Transfers all Presets from the device to the application.

Note that the editor always “receives” the device’s most recently saved Preset settings, even if the selected Preset(s) 
are currently in an edited (unsaved) state.

Presets Panel

The Presets Panel lists Channel locations (01A through 32D) that correspond to the respective  
numbered User Bank Channel locations within your POD HD300 device’s internal memory.  

Channel number

Currently loaded Preset 
(indicated by arrow at left)

Selected Preset
(highlighted) 

The Presets Panel

• Load a Preset - Double-click on any Preset to load its settings into the editor, or hit “Enter” on 
your computer keyboard to load the currently selected Preset. 

• Select a Preset - Click once on any Preset to “select” it. Note that this does not load the Preset in 
the editor, but rather allows you to perform actions on the Preset - such as to “Send” or “Receive” 
Presets (see “Save Panel” on page 1•2). It is also possible to select multiple Presets: 

• Press and hold your Shift key+click to select a contiguous number of Presets.

• Press and hold your Cmd key+click (Mac®) or Ctrl key+click (Windows®) on the desired 
Presets to select a non-contiguous number of Presets.

• “Insert” a Preset into a different Channel location - Click on a Preset and drag it up or down 
within the Presets Panel. Drop the Preset onto the desired Channel location to move the Preset 
there.

 

Note: Since the “insert” action re-orders Presets in the application, all the moved Presets are now in different 
Channel locations as compared to the Channel contents within your device’s User Bank and, therefore, are 
marked as “unsaved” in the Presets Panel. Use the Send buttons in the Save Panel to save the new Channel 
settings to your POD HD300.  
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• “Swap” the Preset settings between two Channel locations - Click on a Preset to select it, then 
press your Shift key and left-click and drag the Preset to the new desired Channel location. 

• Copy & Paste a Preset to a new Channel location - Click on a Preset to select it. Then press 
your Option key (on Mac®) or Ctrl key (on Windows®) and left-click and drag the Preset to 
the new desired Channel location.

• Save a Preset to your computer - There are a few ways to save a copy of the currently loaded  
Preset to your computer:

• Use the File menu’s “Save As” command (see page 2•2 for more about saving  and opening 
Preset and Bundle files). 

• Drag a Preset (or multiple selected Presets) from the Presets Panel directly onto your 
Desktop, or into any folder on your computer. 

• To rename a Preset - Select the desired Preset, wait a second, then click again directly on the 
Preset name. You’ll see the Preset’s name become highlighted. Type in your own text and hit the 
Enter key.

Note: Changing the name of the Preset in the Presets Panel is not reflected on your device until you “Save” the 
Preset to your device’s internal memory, via the Send functions in the Save Panel.

 

• Unsaved Preset indicator - Whenever a Preset’s settings or name has been changed from the 
saved state of the Preset that resides in your device’s internal memory, its title appears in amber 
text and an asterisk (*) indicator  appears to the right of the Preset name in the Presets Panel, 
as shown below. Use the Send buttons within the Save Panel to “Save” edited Presets to your 
device’s internal memory.

Signal Flow Panel

The Signal Flow Panel provides a handy visual reference of the enabled/disabled state and signal flow 
position of the Amp and all FX models for the loaded Preset.

Gate   Wah  FX1 Amp Volume FX2 FX3 Reverb 
The Signal Flow Panel

Enabled/Disabled State

The Amp, FX1, FX2, FX3 & Wah models each include an enable/disable “LED” button (found at 
the left of their FX Panels). The icon for the respective effect within the Signal Flow Panel dims to 
indicate its disabled state:

FX1 Enabled FX1 Disabled
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Model Position

The position you see the models appear in left to right in the Signal Flow Panel is precisely the order 
your input signal flows through them. Note that when you toggle an effect’s “Pre/Post” position switch 
(available within FX1, FX2, FX3, Volume and Reverb panels - see page 1•8), the Signal Flow Panel 
display dynamically changes to show you the new FX ordering.   

“Pre” position “Post” position 

Amp & FX Panels

These panels provide you easy access to the individual parameters of each Amp and FX model that 
make up your Tone, making deep editing easier than ever! 

Working with Panel Controls

There are several ways to access your Amp & FX controls. To follow are functions that are common 
within the application’s Edit Panels.

• Knob controls - Click and drag any knob vertically to adjust its value. Or, click to “select” a 
knob and then use your computer’s arrow keys or mouse wheel to adjust it. Also, simply hovering 
your mouse cursor over any knob allows it to be adjusted via your mouse wheel. Most knob 
controls also include a numerical indicator/edit box that provides access to the parameter value 
as well (see the following description).

• Mix knob value indicators - When adjusting the Mix knob (as well as various other knobs not 
paired with a numerical edit box) within the FX Panels, you’ll see the following two indicators 
to assist you in dialing in the desired setting:

Tooltip value indicator

Value display

Adjusting an FX Panel’s Mix knob

• Numerical indicator/edit boxes - The white text boxes that show numerical values serve as 
handy indicators for your settings. You can also click and drag up/down to adjust their values, 
or double-click within any box to type in a specific numerical value. Also, simply hovering your 
mouse cursor over any numerical edit box allows it to be adjusted via your mouse wheel.

Double-click and type in a valueClick and drag vertically
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• Enable/Disable FX models - At the left of the Amp, FX1, FX2, FX3, and Wah Panels, you’ll see a 
little “LED” control. Click directly on this LED to toggle the model between enabled or disabled. 
You’ll see the LED and all edit boxes dim to indicate the model’s disabled state. Note that you’ll 
also see the model’s icon within the Signal Flow Panel dim when disabled.   

FX1 Enabled

FX1 Disabled

Amp Panel

Amp enable/disable

Power Amp parameters

Tone controls

Amp selector Cab selector 

Amp model type Mic selectorE.R. control

• Amp enable/disable - When disabled, bypasses the Amp, Cab & Mic models, as well as the 
Power Amp & DT panel settings. When the Amp panel is disabled, the CH VOL knob changes 
to an active BYP VOL (bypassed volume) knob, providing level adjustment.

 

BYP VOL becomes availableAmp disabled

Amp Panel - Amp Model is in the disabled state

Note: The FX ONLY button on POD HD300, when activated (lit), will also disable the Amp panel. However, 
the FX ONLY button setting is a Global one, and its state is not saved with any Preset. Your Amp panel enable/
disable state is saved with the Preset, and is over-ridden if the FX ONLY button is active.

• Amp selector - Use the familiar rotary Amp selector knob, or click on the Amp Model menu to 
select an Amp by name. 

TIP! We’ve added several Amps in version 2.0 and later - click the Amp Model menu to access these additional 
Amps at the end of the Amp Model list.
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• Amp model type switch - This is the equivalent of the Amp model type option found in the 
POD HD300 device’s SETUP menu. You can choose Full to utilize the full Amp model, or 
Preamp to utilize only the preamp section of the selected Amp model.

TIP! As of version 2.0, we’ve added the “Vintage Pre” instrument preamp model within the FX1 group, which can 
be used along with an Amp Model, or on its own. Click on the FX1 panel’s Model Menu to find it near the end 
of the list.

• Tone controls - Just as on your POD HD300 hardware, use the knobs here to adjust the Amp’s 
gain & EQ. 

Note: The PRESENCE knob in this panel is the equivalent of the AMP - Presnc control found in the Edit Mode 
of your device.

• Early Reflections (E.R.) control - Add the desired amount of reflective “room” sound to your 
amp tone. This is the equivalent of the AMP - E.R. control found in the Edit Mode of your 
device.

• Mic selector - Choose from among the 8 different microphone models to use to mic your Amp.

• Cab selector - Choose from among the list of speaker cabinets to use with your Amp.

TIP! Choose the “None” option from the Cab Model menu to remove the Speaker Cabinet and Mic modeling 
from your Amp tone.

• Power Amp parameters - The 5 knobs here relate to the “Power Amp” parameters (Master 
Volume, Sag, Hum, Bias & Bias Excursion) whenever a “Full” Amp Model is in use . These are 
the equivalent of the Power Amp options within the device’s Amp Edit Mode screens.* When 
adjusting one of these knobs, its value is displayed as a numerical tooltip and as a meter within 
the Amp Model selector area, as shown below:

The Power Amp parameter knobs - values indicated while adjusting

* Note: When a Preamp Model is in use, the “Power Amp” knobs are not displayed at all within the POD  HD300 
Edit Amp Panel.
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DT Series Amp Controls

Below the Amp Model settings within the Amp Panel is a set of DT Series Amp options. These controls 
are used to configure the DT50™ or DT25™ amplifier’s analog power amp Topology parameters for 
the selected Amp Model. These settings are saved with your Preset, but only utilized when your POD 
HD300 is connected to a Line 6 DT Series amplifier via the L6 LINK™ connection.

Class switch Topology Voicing 
selector 

Pentode/Triode 
Mode switch 

Amp Panel - DT Series amp controls

• Class A - A/B - Toggles the DT power amp to function in Class A or Class A/B operation.

• Topology - Chooses the DT Negative Feedback Loop Topology type (I, II, III or IV).

• Mode - Selects the DT power amp tube mode between Pentode or Triode.

Please also see the and additional POD HD - L6 LINK documentation available at http://line6.com/support/
manuals/ for more details about these DT Series amplifier settings and L6 LINK connectivity.

FX Panels

Below the Amp Panel you’ll see a dedicated Edit Panel for each of the available FX. For all Edit Panels, 
except for the Gate,Volume & Tempo, a Model menu provides a list of FX models. You’ll see that the 
controls displayed within the Edit Panel are specific to the Model selected. To follow are descriptions 
of the controls within the FX Panels (also see page 1•5 for common Edit Panel options).

FX1 Panel

FX model menuModel-specific controls

Enable/Disable LED switch Pre/Post position switch

• Pre/Post position switch - Toggles the FX model’s position within the signal chain to be before 
the Amp (“Pre”) versus after the Amp (“Post”). You’ll see the exact position of the FX reflected 
within the Signal Flow Panel.  

• FX Model menu - Click the down arrow to select from the list of Models. The FX1 panel 
offers a large assortment of Dynamics, Filters and “Stomp” type FX to choose from (overdrives, 
distortions, fuzzes, compressors, EQs and more!). 

Note: See “Pedal Control” on page 2•4 for info about controlling the FX1 Pitch Glide!

http://line6.com/support/manuals/
http://line6.com/support/manuals/
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FX2 & FX3 Panels

The FX2 & FX3 Panels include all the same controls as the FX1 panel (as described above), as well as 
an additional “Tap” control. The FX2 panel offers several tasty Modulation type FX (phasers, choruses, 
rotary speaker, etc.). The FX3 panel offers an arsenal of Delay type FX (analog & digital echoes and  
delays).

Tap Ctl selector Speed control

Tap Ctl selector Time control

• Tap Control selector - For any effect model selected within the FX2 or FX3 Panels is the option 
to select “Control” or “Don’t Control,” allowing you to choose to have the effect’s modulation 
or delay time follow the current Tap Tempo value, as configured within the Tempo Panel. You’ll 
also see the following controls:

• FX2 Speed - This knob & edit box allow you to configure the modulation rate. With the 
Tap selector set to “Don’t Control,” you can set the Speed manually, independent of the 
current Tap Tempo. With the Tap selector set to “Control,” this setting is disabled.

• FX3 Time - This knob & edit box allow you to configure the Delay time. With the Tap 
selector set to “Don’t Control,” you can set the Time manually, independent of the current 
Tap Tempo. With the Tap selector set to “Control,” this setting is disabled.

Reverb Panel

Pretty straight-forward here... The Reverb Panel offers the same set of controls as the FX1 Panel, 
except that the Reverb panel offers no Enable/Disable switch at the left. Just turn the Mix knob to 0% 
if you don’t want any Reverb added to your signal. Within the Effect Model menu you’ll find a number 
of Reverbs in assorted flavors.

Gate Panel

The Gate effect is always in a fixed position (the first item in the signal chain), therefore, no Pre/
Post switch is offered. Also, note that there is no Enable/Disable LED switch at the left of the panel, 
however, you can select “Off” within the Mode menu to completely disable it.

Mode menu

• Mode menu - Select between  “Gate” (a Noise Gate), “NR” (Noise Reduction), both, or “Off.” 
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TIP! As of version 2.0, we’ve added an additional ‘Hard Gate” model within the FX1 group. Click on the FX1 
panel’s Model Menu to find it at the end of the list.

Wah Panel

Like most other FX Panels, the Wah Panel offers an LED Enable/Disable switch and model menu. The 
model menu offers several classic Wahs for your choosing. The Wah effect is always fixed in the “Pre” 
signal flow position.

Position controlWah enable/disable switch Model menu

• Position - Use the knob or edit box to preview the Wah at different static position settings. This 
will audibly function whenever the Wah model is enabled. Note that this knob is for previewing 
the effect only and its setting is not saved with your Preset.

• Enable/Disable LED switch - This allows you to toggle the Wah’s enabled/disabled state. Note 
that this action is the equivalent of pressing the pedal’s “toe” switch on your device, which not 
only turns the Wah on/off, but also toggles the pedal to the VOL assignment. This setting is 
stored within your saved Preset. See “Pedal Control” on page 2•4 for more about the POD 
HD300 pedal behaviors.

Volume Panel

The Volume effect is always “on” whenever the POD HD300 pedal is set to control it and, therefore, 
offers no Enable/Disable LED switch. Use the options in this panel to edit the pedal behavior.

Minimum & Maximum pedal controls

• Min & Max controls - Use these knobs to limit the Min (“heel down” position) and Max (“toe 
down” position) values for your controller pedal. 

• Pre/Post position switch - Toggles the Volume effect’s position within the signal chain to be 
before the amp (“Pre”) or after the amp (“Post”). You’ll see the exact position of the effect 
reflected within the Signal Flow Panel.

Tempo Panel 

Tempo edit box Tap button

The Tap button is the equivalent of the TAP footswitch on your device. Click rhythmically on the Tap 
LED button to set the Tap Tempo for device, which your Modulation (FX2) and Delay (FX3) models  
can follow (see “FX2 & FX3 Panels” on page 1•9). The edit box indicates the numerical tempo value. 
Alternately, you can click and drag, or double click in the Tap edit box and type in a specific BPM 
value. 
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Menu Commands

To follow are descriptions of the application’s menu commands and their functions. The location of 
some commands are different on Mac® versus Windows® systems, as noted below.

POD HD300 Edit (This menu is shown only on Mac®)

• About POD HD300 Edit - Launches the About box, which includes info about your connected 
hardware and software version.

• Quit POD HD300 Edit - Exits the application.

File (Also see “Saving and Opening POD HD300 Preset Files” on page 2•2.)

• Open - Allows you to load a saved POD HD300 Edit Preset (.h3e) file from any folder on your 
computer. 

• Save As - Allows you to save a copy of the loaded Preset as a POD HD300 Edit Preset file (.h3e) 
to any folder on your computer. 

• Save Bundle - Allows you to save all current Preset settings as a POD HD300 Edit “Bundle” 
(.h3b) file to any folder on your computer. 

• Load Bundle - Loads a saved POD HD300 Edit “Bundle” (.h3b) file from any folder on your 
computer, replacing all Presets within the application. 

• Exit (Windows® only) - Exits the application.

Help

• POD HD300 Edit Help - Launches this PDF document you are now reading.

• Online Help - Takes you directly to the Line 6 Community site, the place to find additional 
documentation, FAQ’s, User Forums, Technical Support, breaking news and more!

• CustomTone.com - Takes you to the Line 6 CustomTone site, where you can share your Tone 
Presets with thousands of other Line 6 users, and download free Tones from the huge library!

• About POD HD300 Edit (Windows® only) - Launches the About box, which includes info 
about your software version and connected device.
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WorkfloW
In this chapter, we’ll focus on the common tasks you’ll perform with the POD® HD300 Edit application.

Overview

Once the POD HD300 Edit application is launched, it automatically “receives” the complete set of 
saved Presets from your device’s User Bank into the application, allowing you to view or customize 
any Amp & FX models’ settings. While connected, communication between the application and your 
POD HD300 device’s internal memory is instant - adjust any parameter within the application’s loaded 
Preset and the modified settings are heard on your device. Likewise, adjustments made to your device’s 
controls are visually reflected in the software. 

Two-way communication exists between your device & computer via the USB connection

This interactive communication allows you to tweak any individual Amp or FX models’ settings within 
the application GUI and instantly hear and preview the changes made on your POD HD300. These 
settings changes are temporarily stored on your POD HD300 - that is, they do not overwrite the stored 
settings until you choose to save the Preset. You can also move the Tone Presets to different User Bank 
locations (01A through 32D) within the application, to manage the contents of your device’s User 
Bank Presets order. Once you are done with your Tone tweaking, you can “send” one or all the current 
Tone Presets from the application to your device, to save all settings within your device’s internal 
memory. You can also choose to save Presets to your computer’s hard drive to build an unlimited library 
of Tones, which you can reload into the application, and to your POD HD300, at any time. Read on 
for a tour of the application’s features!

Computer Connectivity

To put POD HD300 Edit to work, connect your POD HD300 device to your computer’s USB port to 
establish two-way communication. Exit any Line 6 applications that might be running, and with your 
POD HD300 device powered on, launch POD HD300 Edit:

•	 On Mac®, go to Applications > Line 6 > POD HD300 Edit

•	 On Windows®, go to the Start button menu > Programs > Line 6 > POD HD300 Edit

Upon launch, the application will detect your POD HD300 and automatically retrieve and load all the 
device’s current Tone Presets and their last-saved settings. You’ll see an indicator at the bottom of the 
application window informing you of the device connection status:
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If you see the “No Line 6 device” alert, exit the application and check that your device is correctly 
connected and powered on. 

Note: It is possible to disconnect your device from your computer to run POD HD300 Edit in “Offline Mode” 
(see page 2•3). 

Saving and Opening POD HD300 Preset Files

Note that there are two methods for “Saving” within the Line 6 POD HD300 Edit application. The 
Save Panel allows you to “Send” one or all Presets from the application to your POD HD300 device - 
see the “Save Panel” on page 1•2.

The other way to “Save,” as covered here, is to create a copy of a Preset to any folder on your computer 
as a POD HD300 Edit Preset file (.h3e) file. This allows you to create a library of .h3e Preset files that 
can be reloaded onto your device anytime! 

To Save a Preset to your Computer:

• Double-click on a Preset within the application’s Presets Panel to load it and select “Save As” 
from the File menu. This launches the familiar Mac® or Windows® file “Save As” window, 
where you can edit the file name and choose a destination folder. By default, all .h3e files are 
saved to:

• Mac® - /Documents/Line 6/Tones/POD HD300 Edit folder

• Windows® - \My Documents\Line 6\Tones\POD HD300 Edit folder

• It is also possible to drag any Preset from the Presets Panel and drop it onto your Desktop, or 
into any folder on your computer to copy it there. Or, select multiple Presets in the Presets Panel 
(using  Shift+left click or Ctrl+left click) to drag and Save copies of each in one drop!

To Save a Bundle to your Computer:

POD HD300 Edit allows you to instantly save all the applications’ current Preset settings into one 
consolidated “Bundle” (.h3b) file. This is extremely handy for making a complete backup of all your 
current Presets, allowing you to load them all back to your device at any time! Just go to the File menu 
and select “Save Bundle” to launch a “Save As” dialog, where you can enter a name and choose any 
folder to save the Bundle file (the default Bundle folder locations are shown above). Note that the 
Save Bundle feature always includes all 32 Banks of Presets, regardless of any Presets(s) that might be 
selected within the Presets Panel.

To Open a Preset or Bundle File from your Computer 

When opening a Preset or Bundle file, the Preset(s) are loaded into the application and appear as 
“edited.” Once you are ready to commit these to your device, use the Save Panel “Send” functions.

• To open a Preset - Select “Open” from the application’s File menu and browse to the location 
where your Preset (.h3e) files are stored (the default Preset folder locations are shown above). 
Selecting a Preset file loads its saved settings, replacing the currently loaded Preset and its 
Channel location within the application. 
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• To load a Bundle - Select “Load Bundle” from the application’s File menu and browse to the 
location where your Bundle (.h3b) files are stored (the default Bundle folder locations are shown 
above). Selecting a Bundle file loads its full set of 128 Presets, replacing all the currently loaded 
Presets within the application. 

• Alternatively, you can drag a Preset or Bundle file from any folder on your computer and drop it 
directly in the POD HD300 Edit window to load the file’s settings. 

POD HD300 - Manual Mode & Quick Loop

The POD HD300 “Manual Mode” and “Quick Loop” functions are not accessible within the POD 
HD300 Edit application. These features are still available via the device’s on-board switches while 
using POD HD300 Edit, however, there are no functions within the application’s GUI to specifically 
control or save Manual or Quick Loop Modes. The following behaviors apply: 

• If you set your POD HD300 device into Manual Mode or one of the Quick Loop (Record, 
Overdub or Play) Modes, the application simply remains showing the same currently loaded 
Preset, even though your device’s Tone may be changed as you adjust the hardware controls.

• When the device is in Manual Mode or Quick Loop Mode, clicking on the application’s Save 
Panel - Receive button will receive the stored Preset from the device’s internal memory (rather 
than the device’s Manual Mode settings). The device remains in its current Manual or Quick 
Loop Mode.

• Double-clicking on a Preset within the Presets Panel loads the saved Preset in the application 
and on the device:

• If the device is currently in Manual Mode, this action will force it out of Manual Mode, and 
the saved Preset settings will be loaded on the device (replacing any Manual Mode Amp 
tone knob values). 

• If the device is currently in Quick Loop Mode, it will simply remain in this mode, and the 
saved Preset settings will be loaded on the device. 

POD HD300 Edit - Offline Mode

In some cases, you might want to load previously saved Presets or a Bundle from your hard drive, tweak, 
rename or reorder your Presets, and save the files back to your computer without committing them to 
your POD HD300 device... No problem! To do this, launch the POD HD300 Edit application without 
your device connected. You see the “No Line 6 Device” alert at the bottom of the application - which 
means you have launched the application in “Offline Mode.” 

Load your desired Preset or Bundle file using the File menu’s “Open” commands, edit to taste and 
save the file back to your computer. When you are ready to save the Presets or Bundle to your device, 
connect your POD HD300 device and then launch the application. Open the desired Preset or Bundle 
from your computer, and use the Save Panel’s “Send” functions to save the desired items into your 
device’s memory.
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Pedal Control

As covered in the POD HD300 Advanced Guide, your POD HD300 pedal can be assigned to  control 
the Wah, Volume & FX1 Pitch Glide. Here are a few helpful notes about the pedal behaviors.

• For most Presets, you’ll see that the device’s “Wah” pedal setting controls the Wah effect, and the 
“Vol” pedal setting controls the Volume effect as the default settings. 

• Alternatively, for any individual Preset, you can configure the FX1 Pitch Glide effect to be 
controlled by either the “Wah” or “Vol” pedal assignment by way of the Pitch Glide’s “PEDAL” 
setting:

Select the Pitch Glide model

Choose your Pedal control option

• The Don’t Ctl setting leaves the “Wah” and “Vol” pedals assigned to controlling the Wah 
and Volume FX, respectively.

• The Wah:Glid setting assigns the “Wah” pedal to control the Pitch Glide effect. Note that 
the Toe switch of your POD HD300 pedal will toggle the pedal between controlling the 
Volume and Pitch Glide model with this setting. You’ll also see the Wah panel’s enable/
disable switch set to “disabled” automatically.

• The Vol:Glid setting assigns the “Vol” pedal to control the Pitch Glide effect. Note that the 
Toe switch of your POD HD300 pedal will toggle the pedal between controlling the Wah  
and Pitch Glide model with this setting.

Note: Whenever your device’s pedal is actively controlling the FX1 Pitch Glide, you’ll see both the WAH and 
VOL LEDs next to the on-board pedal lit to indicate this. 
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line 6 Monkey™ & additional resoUrces

Line 6 Monkey™ is the intelligent updater utility automatically installed with the POD® HD300  
Edit application, or available from line6.com/monkey. It is highly recommended that you run Line 6 
Monkey often to be sure you have all your Line 6 products updated and registered.  

Using Line 6 Monkey

With your POD HD300 connected to your computer (see “Computer Connectivity” on page 2•1), 
power on your device and launch Line 6 Monkey:

•	 On Mac®, go to Applications > Line 6 > Line 6 Monkey

•	 On Windows®, go to the Start button menu > Programs > Line 6 > Tools > Line 6 Monkey

If Monkey prompts you to register your POD HD300, then please do so now - it may be required to 
register to obtain some product updates. Follow the prompts through the quick online registration. 
Return to Line 6 Monkey once you’ve completed the registration. 

Monkey will then display your POD HD300 Device Firmware versions, available Applications and any 
available updates. It is highly recommended to update all items for which newer versions are available!

The Line 6 Monkey Updates screen, with POD HD300 connected

http://line6.com/monkey/
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As an example, in the above screenshot Monkey has detected that a newer Firmware - Flash Memory 
version is available. In this scenario you can select the Flash Memory item and click Update Selection. 
Be sure to read the prompts carefully and Monkey will assist you in performing the update in minutes. 
It is especially important not to disturb the devices’ controls and cable connections until the update 
fully completes!

Additional Resources

Hungry for more info? We’ve got plenty of helpful online resources, just a click away.

• Additional Help documentation covering POD HD300 hardware and related products is 
available from the Line 6 Support site: 

Line 6 Product Manuals

• Visit the CustomTone™ site where you can share your POD HD300 Tones with the world, and  
download free Tones created by Line 6 and other users just like you.

CustomTone 

• Can’t get enough of that Line 6 Gear & accessories? Head on over to the Line 6 Store!

Line 6 Online Store

• For Line 6 Support, including Customer Service, the searchable Knowledgebase, Community 
Forums, Videos and more:

Line 6 Support

http://line6.com/support/manuals/
http://line6.com/customtone/
http://www.line6.com/store/storefront.html
http://line6.com/support/

	POD® HD300 Edit Pilot's Guide
	Graphical User Interface
	What’s in it for Me? 
	The Main GUI
	Save Panel
	Presets Panel
	Signal Flow Panel
	Amp & FX Panels
	Menu Commands

	Workflow
	Overview
	Computer Connectivity
	Saving and Opening POD HD300 Preset Files
	POD HD300 - Manual Mode & Quick Loop
	POD HD300 Edit - Offline Mode
	Pedal Control

	Line 6 Monkey™ & Additional Resources
	Using Line 6 Monkey
	Additional Resources


